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Mouse and Screen Basics 
Mouse Operation: 

The program is designed to run with a 3 button mouse; each button is used for a different purpose and it can greatly 

speed operation to get used to using these buttons.  It can be run with a 2 button mouse, but this is 

NOT recommended. 

The left hand button fulfils the normal mouse function of "select".  When the cursor is over an item, pressing the 

left hand mouse button will cause that item to be selected and if it is a push button of any kind, it will be pushed.  

Active or selected items often have a red or black highlight around them so you can easily tell which item is active.  

This is important to know as key presses on the keyboard are only directed at the active window or item; i.e. if you 

want to type something into a box, you have to click on it (select it) first!   This button is referred to as the "select 

button" and if you are instructed to "select" an item, that means move the cursor above the item and click the left 

hand button. 

The middle mouse button has a special purpose which is to ‘stop’.  Whenever it is pressed, whatever the software 

is doing is stopped.  If it is pressed while the move is running, then the move is stopped.  If you press it while the rig 

is already stopping, it will stop even faster.  This is a safety feature to aid the user, it does not replace the emergency 

stop button and should not be regarded as fail-safe.  This button is referred to as the "mouse stop button".  It does 

not work is the mouse is off of the program screen or on the border of a window.  In certain graphical displays, this 

button may be used for other purposes. 

The right hand button is used to store data.  If you want to store data into the program, then pressing the right hand 

button over a box will store relevant information into that box.  This button will be referred to as the "mouse store 

button" and its exact operation is covered under relevant sections of the full Flair manual. As with the "stop" button, 

this function is used differently in certain graphical sections of the programme.  In some cases when it is 

appropriate, a right click will cause the setup appropriate to that button to appear. Generally “store” works for 

numerical boxes, and “setup” for push buttons where it is appropriate. 

 Select  Store 

Numeric Entry: 

Motion Control is intimately connected with numbers, and you will sometimes have to type numbers in to let the 

program know different values e.g. camera speed etc. etc.  Numerical entry is consistent throughout the program and 

is done in the following manner: 1) Select the relevant box. 2) Type the value in newly (you can't edit the existing 

value) 3) Press either of the "Enter" keys on the keyboard.  If you make a mistake while you are typing, you can 

correct it with the backspace delete key (usually marked with an arrow pointing left and directly above the large 

Stop 
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"Enter" key).  The value is entered once an "Enter" key is pressed.  If you change your mind half way through 

typing in a new value, pressing the "Esc" key will abort the change and return the number back to its original value. 

Input Focus: 

The idea of input focus is connected with a graphics user interface.  Normally when you are running a program, you 

are asked to enter values, or make specific selections; in this way, the program knows where to direct input 

information.  When you are running a graphics user interface, the key presses on the QWERTY keyboard have to be 

directed at a specific entry box or part of the screen.  The way this is handled is by assigning input focus to a 

specific box or part of the screen, and then all key presses are directed at that. When an entry box or a part of the 

screen has input focus, it will normally have a highlight box placed around it so you can identify it.  In this program, 

most of these highlights are either black or red.  The way to give input focus to a specific box is to click on it (select 

it) with the left hand mouse button, and then you will see that when keys are pressed, they are entered into that box.  

If you are pressing keys, but nothing is happening in the box you want, either you are trying to change a value that 

you should not change at that time, or you have not given that box input focus. 

 

QUICK GUIDE 

The Quick Guide: 

The quick guide is intended for a new user who just wants to make some simple moves.  It assumes that the system 

has been fully set up and is ready for use.  For more in-depth information, turn to the relevant sections of the full 

Flair manual.  Given a system that is correctly set up a new user should be able to start shooting moves within a very 

few minutes! 

As you read this guide do each step as it is described and you will discover how easy the system is to run. 

Several of the functions described here can be done with either the mouse or with keys on the Hand Held box. This 

guide has been written using the mouse features in every case, but you can also use the hand held box if you find it 

easier or quicker. 

 

 

INPUT FOCUS 
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Numeric Display: 

When the program first loads, you will be presented with the Main Display which is composed of the Top Menu 

Bar, the Numeric Display, the Side Menu Bar on the right and the Control Box at the bottom. Each part of this 

display is described here in turn. 

 

The numeric display is composed of lines containing data about frame counts and motor positions for those frame 

counts.  Each of these lines is called a waypoint, and when the move is executed, each motor is driven from one 

waypoint to the next at such a speed that it arrives at the position specified in the next waypoint at the correct time.  

If there are more waypoints, it will then continue on to the next one.  This is the simplicity of Motion Control.   

When the program first loads, there is only one line, and the positions for this line are blank, after a couple of lines 

have been added, the display could look like this: 

 

 

The frame count column is down the left hand side of the screen, and frame count numbers are entered in here by 

selecting the entry you want to change with the mouse so that a black square appears around it, and then typing in 

the new value followed by the "Enter" key.  The next column is the position number, and is to let you know which 

position line you are one.  If you have more than about 16 lines, then they will scroll up and down, and then this line 

numbering becomes vital.  The next column is optional and may not appear on your system, it is "Target" and is not 

necessary for simple moves and are therefore covered later in the manual. 

The rest of the screen is filled with axis positions in vertical columns, with the axis name at the top, and a position 

stored in each waypoint that is entered.  Axis positions are modified in the same way that frame counts are; simply 

select the number you want to change so that a black square appears around it and then type in the new value 

Run Control 
Bar 

Sidebar Menu 

Top Menu 

Slider Bar 

Goto Slider Bar 

Control/Edit 
Toggle 

Input Focus Box 
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followed by "Enter".  Normally positions are entered into these boxes by telling the computer to "store" the current 

axis positions. (see later). 

Moving the Motors: 

When the system is first powered up all the motors are turned off (disabled) and the user has to enable them. 

The state of a motor is indicated by the colour of its axis name near the top of the numeric display, and by the colour 

of its "current position" which is directly above.  If the axis name is white (or grey), that indicates that it has not been 

enabled - simply click on the axis name, and it should go black indicating that the user has enabled the motor and 

wants it to be engaged (under control of the system).  If this is successful, then the current position, which was also 

white, will go black. If the number goes white again immediately or within 3 seconds that means there is no motor 

attached or there is another fault. 

In this diagram, the Track is enabled and under power, the Lift is enabled, but has not engaged and the Rotate is not 

enabled, and therefore is not engaged.  In summary: the colour of the axis name shows if it has been enabled by the 

user, and the colour of the current position shows if it is engaged and in the correct position.  

Use 

left and right mouse 

Once the motor is engaged the axis may then be moved on the hand held box or using the mouse or keyboard. To 

move using the mouse simply place the mouse on the current position numbers and use the left and right mouse 

buttons to move the position up or down. Use the + and – keys on the keyboard to speed up or slow down the 

motion. To use the keyboard, place your mouse on one of the position numbers and then use A & Z for the first axis, 

S & X for the second, D &C for the third etc.  On the HHB (Hand Held Box), simply move the joystick, or push the 

button associated with that axis, and it will move.  Using the "fast" and "slow" buttons on the hand held box, you 

can increase and reduce the speed that it travels.  If you are unsure of which button/joystick does what you can view 

the assignments in the “HHB Setups” in the “Setups” menu from the Top Menu (Setups->HHB Setups). 

Programming a Move: 

Now start programming the move.  Use the mouse (or other input devices) to move the camera to the correct 

position for the start of the move, then select the first line on the numeric display, and click on the "Store Axes" 

button on the side menu bar to the right of the axis positions display. (If the “Control Menu” is displayed, click on 

this label so that the “Editing Menu” is displayed and then the “Store Axes” button will be available).  This will 

store the current positions into the first waypoint.  Next move the camera to your second position (moves need at 

least 2 positions), press the "Add Line" button to add a second waypoint to the display, then press the "Store Axes" 

button again, and the new positions will be stored into the second line.  If needed, change the frame count of the line 

to the desired frame count, and then continue adding and storing waypoints until the move is entered.  Note that 

frame counts must always increase through the job, getting larger and larger with each waypoint. 

Hint: You can also add, insert and delete lines by using the down arrow, insert and delete keys on the keyboard. 

A simple 2 point move could look like this. 

Use left mouse button 

here to enable or 

disable the axis. 

buttons here to move an axis. 

Use + and – to change speed. 
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Running a Move: 

Any programmed move can be run from the beginning to the end, from the end to the beginning or from any time 

within the move to any other time in the move.  The simplest form is to run from the beginning to the end; this is 

called a "Forward Run" or "Fwd Run" in its shortened form.  There are several ways to do this, there is a “Fwd Run” 

button on the Run Control Bar, there is also one under the “Run Job” button on the top menu bar, there is also one 

on the Hand Held Box or you could simply press the “F2” key on the keyboard. 

When one of these buttons is pressed, the move is calculated and, if the move is not too fast, the computer will 

prompt you with "Ready to Goto" which means that the current motors positions are not the same as the move start 

positions, and the motors must move to the start position before they can run the move.  If you get an error saying 

the move is too fast then keep reading as all will be explained. 

NOTE on ERRORS: If you get an error saying “missing target position”, turn off Target Tracking in the Control 

Menu at the side. You may get other errors or warnings if this is the first time you have switched on the system and 

the previous user has changed the default settings. If you get a warning saying “Focus follows target only works in 

normal Target Tracking” change the focus type by selecting Job Type from the Top menu and changing Focus to “is 

independent”. If you get an error saying certain axes are not enable or tripped and are you sure you want to run the 

move you can tell it to ignore unused axes by pressing the axis name with the middle mouse button so the button 

disappears. 

The Run Control Bar at the bottom of the screen displays the status of the job and holds the control buttons for 

running the job.   In order to make the system execute a goto, you press the "Goto" button with the mouse. The 

motors will then move to their respective start positions, and the message will change to "Ready to Shoot".  In this 

state or any of the Job running states you cannot input into the system. 

At this point you can run the move.  Press the "Shoot" button, the motors will start moving and the slider at the 

bottom of the screen will also start moving to show the frame count as the move progresses.  When the moves 

completes, the motors will come to rest, and the system will return to its normal input state. 

 

Interrupting a move: 

If the move is shooting and the mouse stop button is pressed, or the "STOP" button on the Control Box is pressed, 

the move will stop, the axes will post-roll, and then will return to the end of the last frame successfully completed.  

If this happens part way through a frame at single framing speeds, the frame will be completed, and then the rig will 

stop.  Once the system has stopped, it assumes that you want to continue to shoot the rest of the move, so it 

Hint: If you want to store a line of current position, 

simply right click (store) over the position number of 

the line you want to store in. 

Hint: If you want to only 

store one axis’ position, 

right click on the numeric 

position you want to 

update. 
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recalculates the move to start where it was stopped, and goes into the "Ready to Shoot" status.  The 2 takes can then 

be matched up and treated as a complete shot. (You may have to cut the camera ramps off when editing film).  This 

feature is not provided for on the Stop button on the Hand Held Box.  If the stop button is pressed again while the 

system is stopping, it will stop all the axes with maximum acceleration - this is deemed to be an emergency of some 

kind. 

You can also run the move from the end back to the beginning.  The procedure is basically the same as the above, 

press the "Back Run" button, press "Goto" if you are so prompted, and then "Shoot". 

If the computer calculates that the move is too fast for the motors to run at that speed, it will suggest a longer overall 

frame count for the move or a slower camera speed.  You can either accept the increase in frames, or modify the 

move (e.g. lower the camera speed or reduce the distance to be travelled). If you run the move too fast for the 

motors they will switch off and will need to be enabled again as described above. The motors will not have lost 

position. 

Modifying a Move: 

If the move does not go in exactly right first time, there are many ways in which the move can be modified. You can 

either insert, delete or modify waypoints.  Deleting waypoints is done by selecting a line (so that the black square 

appears somewhere on that line) and then pressing the "Delete Line" button in the side menu bar, this will totally 

remove a waypoint.  Waypoints can also be inserted.  Insert is actually "insert before", so when you select a line, 

and press the "Insert Line", a new line is put in above the line you selected.  This can be used to enter a new 

waypoint between 2 existing waypoints. 

A good way to change a move is to move the system to one of the waypoints using the “Move To” button on the 

Top Menu Bar, and selecting position from the list that appears, and then typing in the number of the position you 

want to go to.  The system will then say “Ready to Goto” and will move to the desired position when “Goto” is 

pressed.  Once at the waypoint, correct the positions, re-store the waypoint and then re-run the move.  This is the 

preferred method as adding and inserting waypoints can make the move too complicated and can spoil the smooth 

shape of the move.  If an existing waypoint is wrong, move to that waypoint and make it right, then select it and re-

store the new positions. 

Recording a Move: 

Once the move is to your liking, you are ready to record it. 

 
 

 
 

Film Cameras 
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There are several different types of cameras and depending on how much control the software has over the camera 

will vary the way in you will need to set up the camera. 

Mitchell and Fries Cameras 

Mitchell and Fries Cameras with an MRMC motor are the simplest to use.  First you have to engage the camera 

which is done just like the other axes, simply press the "Frame" button at the top of the numerical display, the 

camera will engage and zero itself.  Then change the button on the Run Control Bar that says "Rehearse" to 

"Record" as above and run the move.  At the beginning of the move, the camera will be started, and then the move 

will be shot with the camera running throughout and at the end of the move, the camera will stop. 

Panavision, Arri, Moviecam and other partial control cameras. 

With most cameras you will only have software control of starting and stopping the camera as well as synchronising 

to the camera exposure (multiple passes of the same move need to be synchronised to the camera so that they match 

exactly). A suitable camera interface cable will connect the camera to the Flair hardware. Once connected you use 

the External Camera Setup from the Setups Menu to setup the correct parameters for that camera (See Setting up an 

External Camera). Once the camera setups are done you will need to do the following to shoot. (1) Change the 

button on the Run Control Bar that says "Rehearse" to "Record" as above. (2) Set the camera speed on the camera to 

match your chosen camera speed in the software. (3) Run the move by pressing Forward Run. The camera should 

start and stop when the move is run. You can test the camera using the “Turnover” button in the Run Control Bar. 

You can also see the frame rate the software is getting from the camera by using the “Test” button in the External 

Camera Setup. 

Arri 435 Advanced (with moco option) 

The Arri 435 Advanced has the ability to be fully controlled by the software similarly to Mitchell Cameras. For this 

the 435 needs to be supplied with a dongle made by Arri called an MCI-1. If your camera has this then the camera 

has the moco option. Using a suitable cable connect the camera to the Flair hardware. Using the controls on the 435 

enable the Step and Direction mode (SD2). The camera will zero itself and when ready the green light will enable. 

The parameters for controlling the camera can now be accessed in Flair from the Camera Axis Setup (not the 

External Camera). The camera should only be enabled in the software by doing Zero->Direct Zero->Camera from 

the top menu bar. This will make the “Frame” button black. Hint: You can also enable an Arri camera by pressing 

the “Frame” button (like with a Mitchell) but only if the “Zero Offset” in the Camera Axis Setup has been deleted 

(blank) using the backspace key. 

The camera should now be ready to be used and pressing “Turnover” in the Run Control Bar should run the camera 

at the speed shown on the Run Control Bar. You may have to turn External Camera off in the External Camera 

Setup so the software does not think it has 2 cameras running.  To film the move, change the button on the Run 

Control Bar that says "Rehearse" to "Record" as above and run the move.  At the beginning of the move, the camera 

will be started, and then the move will be shot with the camera running throughout and at the end of the move, the 

camera will stop. 

Video Cameras 

Video cameras are effectively just another type of camera that records at 50FPS (or 60FPS, or 24FPS etc.) It is 

referred to by the software as an external camera and depending on whether it is just a camera or a camcorder the 

software may start and stop it and also synchronize to the “shutter” rate.  Using a suitable video camera adapter and 

cable connect the video signal from the camera to the Flair hardware. From this point on the video camera is set up 

just like any other external camera with the exception that the frame rate in the Run Control Bar should be made to 

match the frame rate of the camera or else the software won’t be able to synchronize. Once connected you use the 

External Camera Setup from the Setups Menu to setup the correct parameters for that camera (See Setting up an 

External Camera). Once the camera setups are done you will need to do the following to shoot. (1) Change the 

button on the Run Control Bar that says "Rehearse" to "Record" as above. (2) Set the FPS rate on the Run Control 

Bar to match your camera speed. (3) Run the move by pressing Forward Run. The camera should start and stop 

when the move is run (if it is a camcorder). You can see the frame rate the software is getting from the camera by 

using the “Test” button in the External Camera Setup. 
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Hint: If you require to film some unknown amount before actually starting the motion control movement you can 

press “Turnover” instead of Shoot. This will start the camera. Then when the director shouts “action!” press the 

Shoot button. This will keep the camera rolling while starting the moco shot. At the end of the move press Stop or 

Turnover again to stop the recording. 

The system has numerous advanced features that allow you to change the move in other ways and to affect the shape 

of the curves, but the above guide covers the basics, and should allow you to do repeat or multiple passes of the 

move you want. 

Note: Before using the system for a shoot please ensure you have read the section on Zeroing and what it does. 

Motion Control systems must be zeroed before being used for filming. 

End of Travel Limits 

Most axes have “software limits” or “soft limits” that limit the maximum movement or end of travel and do not 

change from shoot to shoot. There are some axes though that always need changing such focus/zoom axes or track 

(due to using different lengths of rail). Therefore once the axis has been zeroed as above, if the physical end limits 

have changed since the rig’s last use, one should change them in the software. This is done by selecting the axis’ 

setups from the menu (e.g. Setups->Axis Setups->Focus) and changing the “Max Limit” and “Min Limit” values. 

The simplest way is to move the axis manually to one end limit and pressing the mouse “Store” button (right hand 

one) over the numerical entry box and then moving to the other extreme and again storing in the other entry box. For 

a Focus axis zeroed at infinity, the minimum limit is normally 0 and the maximum limit is a positive number. 

Note that in the same window you can also set the maximum velocities and accelerations although these should not 

normally need changing if they have been set before. 

Once the values have been changed you can Accept the changes or by pressing Save, store the changes as your new 

default setting for the next time the system is powered up. 

Hint: Make sure your Max Limit is bigger than your Min Limit or else the motor will no longer move. 

Note that when reading in previously stored jobs all information including soft limits are retrieved with the job so 

changes you may have made will be lost when reading in a job.  Also selecting lenses from the menu will overwrite 

any existing Focus axis setups if that lens has its own focus parameters. 

Zeroing 

Zeroing axes is the way the system knows exactly where each motor is when the system is first powered up so that 

moves can be repeated exactly at any location. It is also important for the system to zero the axes so that it can stop 

motors from exceeding their limits of travel, and so the information export to CGI or imported from CGI will match.  

Zeroing basically involves registering the position of an axis against a known reference point. Normally using a 

built in sensor such as a magnetic switch or optical switch. Full details are covered in the "Axis Set-up" and 

"Zeroing" chapters of the Flair manual but this section will explain what you must do when powering up a simple 

rig such as an Ulti-Head to ensure moves will repeat even if the power is lost or location is changed. It assumes the 

values stored in the program set-ups are correct and have not been changed. 

Most axes such as the Pan and Tilt are at “zero” when they are looking “straight and level”. The system does not know 

where this is when it is first powered up, but by instigating the zeroing each motor will find a sensor and then move a 

certain distance from the sensor to a “zero” or “home” position. 

You zero the motors by choosing Zero->Home Axis->All Axes from the Top Menu, or to zero a single motor such 

as the Pan choose Zero->Home Axis->Pan. Note that if the motors are not enabled then they will not zero as they 

cannot be moved until enabled. Not all motors are zeroed by sensors. Some are zeroed by hand directly. For 

example the Focus motor is normally attached to the lens and the lens moved by hand to “Infinity” focus. There the 

focus is zeroed by selecting Zero->Direct Zero->Focus. Once zeroed the focus motor is enabled so that it can be 

moved by the software. 

It is important that zeroing is done whenever the system is powered up to ensure the moves are repeated exactly in 

the future. 

Hint: It is good to have a visual check too to make sure the axes have zeroed in the right place. Zeroing used to be 

always done visually but with the automated sensors the accuracy of zeroing is increased but do not become 
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complacent and assume that because you have told it to zero it has done so correctly – someone may have changed a 

set-up within the software without telling you. Operators often put visual marks on the axes to be certain they have 

zeroed and are not way off the mark. 

 

Using Mimic Handwheels. 

Moves can be programmed using waypoints but quite often the user requires manual control of the head using 

handwheels to record and then playback a manual movement. Following the procedure below will allow you to 

record and then playback the movement. First though you need to establish the controller for each axis you want to 

mimic. For example let’s say the user wants to record the Pan, Tilt and Focus. 

1) Right click with the mouse on the Pan button in the numerical display to bring up the Axis setups for the pan. 

2) Half way down the screen you will see the settings for the mimic. “Mimic:” has a pull-down selection with 

various choices. Select “Encoder Vel”. 

3) Select the “Controller” to be Mimic 1. This tells the software to use the first Mimic handwheel to control the 

pan motor. You can change the scaling of the handwheels too but 1.0 is normally sufficient. Save and Accept 

your changes. 

4) Press “Next” in the top right hand corner and you will be shown the next axis’ setups, the Tilt. Do the same as 

above but this time setting the controller to Mimic 2. 

5) Press “Next” until you reach the Focus axis setup and repeat steps 2 and 3 this time using controller Mimic 3. 

6) You will now find that the motors move when you move the handwheels. Note if they do not move make sure 

the switches on the handwheel box are not set to off. Hint: You can check the handwheels are working by 

selecting “Setups->Test Mimic Inputs” from the Top Menu bar. 

7) To actually record the motion you need to create a 2 waypoint move. You don’t need any position values just as 

long as there are 2 waypoints. Decide on how many frames you want to record for. It’s normally better to give 

too much than too little and not be able to record everything. You can always stop the recording early. Type the 

number of frames into the second waypoint. 

8) From the Top Menu bar select Mimic->Axis Mimic. Turn on the axes you are recording. 

9) From the side Control Menu change Mimic Off to Mimic Learn. 

10) Press FWD RUN in the Run Control Bar. Do any needed goto. Once in “Ready to Shoot” press shoot and 

recording will start. If you have finished the motion and want to stop any further recording press STOP. 

You will be asked if you want to Truncate your move (as you recorded fewer frames than expected). Simply say 

yes. 

11) To Play back the movement Change Mimic Learn to Mimic Off and run the move as normal. Note that if you 

don’t turn off mimic learn it will simple record again the next time you run the move, overwriting any data it 

has already learnt. 

There are some additional modes for mimic. Most are fully described in the Flair manual but some are described 

briefly here. 

You may notice a slight delay when using the handwheels in Encoder Vel mode. This is because they are limiting 

you maximum velocity and acceleration. If you do not want this change them to Encoder Pos. Note that in Encoder 

Pos they will only move the axis when Mimic Learn is turned on. 

Focus and Zoom motors normally use handwheels with limited rotation (pots) and markings and it is important not 

to lose the relationship between the markings on the lens and the markings on the handwheel. For this the controller 

is sometimes set to Encoder Pot. To use this setting turn the pot to one end (infinity normally) and turn the lens to 

one end too. Then follow steps 1 to 3 above for the relevant axis but setting the controller to Encoder Pot. 

Next zero the relevant controller by selecting Zero->Direct Zero->Mimic Axis 3 or which number is correct. 

Proceed with the rest of the checklist above. Whenever you now turn on Mimic Learn it will do a little “goto” to 

move the motor to wherever the pot is currently set to at which point you will have full control as normal. 
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Storing and Retrieving Jobs 
The Top Menu Bar is composed of a row of buttons across the top of the screen, these buttons allow you to access 

the various features of the program and are always visible to the user. 

 

 
The File selection allows the user to store and retrieve jobs as well import and export different information. 

File->New deletes all existing waypoints and any data associated with them.  Before actually deleting all the data, 

you are prompted to confirm this action.  There are several selections for clearing data but this is the most commonly 

used one. 

File->Reset All deletes the move as above, but also re-reads the configurations of the axes and the system from the 

default values stored on disk. 

File->Reset Warnings re-enables any warnings that have been disabled by the user.  (e.g. “Move exceeds remaining 

film in magazine”) 

“Simple Read Job”, “Read Job”, “Write Job” 

Job storage is a means of saving a job that one has run so that it can be run at a later date simply by retrieving it off 

disk and running it again.  Further data is covered in the "Job Storage" section of the complete Flair manual. Only 

use “Read Job” for retrieving jobs off disk, not “Simple Read Job” unless you are familiar with its use. 

 

Since this is a standard Windows Dialogue Box, you can also delete jobs and create new directories in the usual 

manner.  When you save a job to disk, if you have selected “Auto Inc File Names” in the miscellaneous setups, the 

computer will automatically add a number to the end of the last file name, or increase the value if there is already a 

number there.  This can make life much easier when storing multiple version of a job, for example when you are 

shooting multiple takes of a move, and there is a slight variation between each. 

When storing a job to disk all information is saved including the lens you were using etc. 

Hint: Whenever you run a move the move is temporarily stored in a job file called “current.job”. If you make a 

typing mistake and have not run the move since making the mistake you can always reload the “current.job” file to 

undo you typo. 

“Print”:  See the complete Flair manual for details of this function. 
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File->CGI Import,  File->CGI Export 

These will produce dialogue boxes to allow the user to import or export data between Flair and CGI systems. See the 

Chapter on Data Import/Export in the complete Flair manual for full instructions. 

“Import Text Config”, “View Text Config”, “Imported Files” 

Often the default value for a system will not fit all options, and the user needs to be able to alter some configuration 

of the system. For this special Configuration files can be imported which contain additional information. See the 

full Flair manual for specific information. 

Graphics 

In the Top Menu Bar you will also find the: 

View:  Pressing this button gives you several options to choose from, the first of these is "Numbers" which will 

display the Numeric Display as you have seen so far.  The next 2 options "Graphs" and "Targets" allow you to view 

the move graphically once it has been entered, although Targets  will only display in specific software modes.  The 

following options in the View menu are more advanced and should not be required for normal shoots. See the 

complete Flair Manual for more data. There are some “hot keys” to allow you to access these displays from the 

keyboard.  These are listed in the pull down menu. 

Animation 

Shooting animation is very simple with Flair but please note that only certain cameras can be used since animation 

generally requires the camera to be able to take only 1 frame at a time. Most cameras cannot do this. To shoot 

animation one follows the procedure above for running a move but instead of pressing “Shoot” when prompted on 

presses “FWD STP”. This will take one frame and then proceed to the next frame’s position and wait for the user to 

press “FWD STP” again. If one wanted to shoot repeatedly without being prompted at every frame one would 

change “Single Step” to “Cont. Step” from the Control Menu. Another option is to change “Stop Frame” to 

“Moving Step” in the control menu. This would create motion blur by taking a single frame while the rig is moving 

to the next frame. Various options for animation exist including Time-Lapse by choosing SFX->Film Effects from 

the Top Menu. Help is provided for these in the Full flair manual and in the software. 

Note: Animation is normally done at speeds below 4 FPS otherwise most cameras will expose more than 1 frame of 

film to get up to high speed. 

Part Runs and Gotos 

“Part Run” allows you to run the job from any frame count within the move to any other frame count within the 

move. Select it from the Top Menu,  Run Job->Part Run 

 

 

Sometimes it is necessary to move to a specific frame within the job for example to check the framing or the 

lighting. A quick way is to drag the “Goto Slider Bar” in the Run Control Bar to the frame you want to few. 
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Sometimes though it is easier to type in the exact frame number or waypoint number you want to go to. Simply 

select Goto->Goto Frame or Goto->Goto Pos from the Top Menu and type in the relevant Frame number or 

Waypoint number when prompted. When you have typed in a number the software will prompt you with “Ready 

to Goto” at which point you should press the “Goto” button on the Run Control Bar (once you have checked it is 

safe for the rig to move without hitting anyone” The Goto Menu also has the option to go to Home (“Zero”) 

position. 

Other Useful Shortcuts. 

There are several additional features provided for ease of use, and these are described here: 

1) You can store the system current frame count into a line by pressing the mouse store button with the cursor 

over the frame count that you want to modify.  This is particularly useful when you are inserting a 

waypoint into a move, the best way to do this is to part run the move to the frame count that you want to 

modify, insert a line, adjust the positions of the motors as needed, store in the current frame count of the 

move as above, and then store axes positions. 

2) Once a series of waypoints have been added, you may want to allow more or less time between 2 

waypoints  this can be done by adding the increase (say 25 frames) to the frame count at the second of 

these points, entering that new value, and then continuing all through the move adding 25 to each frame 

count.  If you didn't do this, the section of the move subsequent to your change would also be changed.  A 

shortcut is to simply select the second waypoint, type in the number of frames you want to change it by, 

and press the "+" key to increase that and all subsequent frame counts, or press the "" key to reduce them.  

This feature is called "ripple through" as the effects of any changes you make are "rippled through" the 

move. 

3) When a move has been entered, the entire move can be scaled up or down to make it shorter or longer.  

There is a button labelled "Scale" on the Editing Side Menu Bar, and when this is pressed, a dialogue box 

appears prompting you to enter the new total number of frames.  If your move goes from 0 to 300, you can 

type in 600 in this box, press OK, and the whole move and any associated waypoint frame counts will be 

scaled up to make the whole move last 600 frames.  This is also done automatically by the computer if your 

move is too fast and you accept the number of frames the computer asks for in order to shoot the move (See 

section under running a move). 

4) The stretch feature is an extension of scale.  If you want to extend or compress only part of the move, 

it involves both a scale of that section and a ripple through for the rest of the move.  If you press the 

"Stretch" button on the Side Menu Bar, then you are prompted for the waypoint number of the beginning of 

the stretch, the waypoint number of the end of the stretch, and the desired frame count for the new end of 

the stretch.  In this way the speed of the move through a series of waypoint can be changed without 

changing the timings of the rest of the move. Please note that a new curve will be generated through all the 

waypoints with the new times and areas outside of the “stretched” section may also be changed slightly. 

5) You copy information from waypoint to another.  Select the position box on the line which you want to be 

the destination line, and enter the position number of the line you want to copy AND PRESS ENTER.  

Then all the data from the source line will be copied into the destination line. 

Incremental Frames + Seconds Column: 

The frames column by default displays absolute frames, but can be toggled to display different formats. There is a 

toggle control in the Editing Side Menu Bar 

Positions can be deleted to leave a blank field by selecting the field and then typing the backspace delete key on the 

keyboard.  You can modify a position and all subsequent positions for a given axis by selecting the first field to be 

changed and typing in the amount you want to change it by and ending this with the "+" or the "-" key to either add 

or subtract that amount from that entry and all subsequent entries, as the "ripple through" facility for frame counts 

does. 
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Current Velocities: 

The current positions line can also be used to display the current velocity of the motor.  If the number is clicked on 

with the mouse while pressing the SHIFT key, it will turn blue, and that will show the current velocity of the axis.  

If the axis trips out when it is in this mode, the number turns light blue and continues to show the current intended 

velocity of the axis. 

Blank Entries: 

If a waypoint exists, but a related box is blank, that means that no position has been stored for that axis.  In fact if 

you simply add waypoints without storing any data, you will get entire rows of blank boxes.  The boxes will stay 

blank until some positional information is stored in them.  The significance of a blank box is exactly what you 

would expect, it does not hold a position, and therefore does not affect the move in any way.  If you have data in a 

box, but want to blank it out, select the box by clicking on it, and then press the backspace delete key on the 

keyboard.  You may not have blank entries in the frames column. 

Values Displayed: 

The numbers displayed in the axis positions boxes are generally in display units.  When the axis is set up, it is 

specified what the relationship is between the motor turns, and the distance the axis moves.  This means that the 

computer can interpret motor movement in turns or centimetres, or inches or degrees.  The units that appear on the 

numerical screen will be in the units that the motor has been scaled for.  One exception of this is the focus axis 

which is displayed in display units – like the other axes - when it is acting as an independent axis, but is in terms of 

focus target distance when the computer is controlling the focus (see Job Type Section and Target Distance data 

immediately above). 

The Run Control Bar 

 

 

Cam FPS: This is the speed the camera will run during the move.  Most of the time, the camera speed will be set to 

the move speed, and if you change the move speed, then this value will change accordingly. Occasionally, you want 

to run the camera at a different speed to the move.  This occurs occasionally, but please note that moves shot with 

different camera speeds, but the same move speed will NOT match.  If you wish to change the speed of the move 

and the camera, simply enter the desired speed in the “Move FPS” entry box.  A right click in this box will copy the 

current move speed into the camera speed box.  This box defaults to a disabled state to reduce the change of 

inadvertent changes occurring.  To enable this box, click on the box above labelled “Cam FPS” 

Camera Ramp Frames: 

Just to the right of the speed entry box is a number which indicates how many frames of film will be exposed while 

the camera is ramping up to speed.  If it is 0, it means you can single frame the camera, otherwise it tells you how 

much film will be used on the ramp up, and the ramp down will be the same length.  This is in frames of film; it is 

not a Preroll in frames of time. 

Shoot Slate: is a push button that causes the camera to expose a certain number of frames when it is pushed. It will 

only work when the camera is engaged and is set up to record. 
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Turnover: This is a push button that sets the camera rolling at the current move speed.  It can be used to shoot a 

hold of an inexact length.  When pressed a second time, the camera will stop.  If you are at “Ready to Shoot” and 

you press this button, then the camera will start rolling; if while the camera is rolling, the “Shoot” key is pressed, 

then the move will start in sync with the already running camera.  At the end of such a move, the camera will 

continue running until it is stopped unless there is a post hold set, then the camera will stop after that number of 

frames.  A running camera may also be stopped with the Mouse Stop Button. 

Take:  The Take button will cause the camera to expose one frame at the current camera speed.  If you are at a speed 

higher than a single frame speed, then the necessary ramp frames will also be exposed.  This button does not work 

when you are in a run state such as “Ready to Goto” or “Ready to Shoot”. 

Browse: See full Manual for information on this feature. 

Stop: Stops any ongoing action or will take the system out of a run state (e.g. “Ready to Shoot”) if needed. 

Graphics Display 

Graphic Move Representation: 

The move on any axis can be displayed on the screen as a graph of axis position against time.  When the display is 

changed to "Graphics" by using the "Views" button on the Top Menu Bar, a variable number of graphs are displayed 

on the screen up to the number of axes in the system, and down to 1, along with various functions for viewing and 

manipulating these graphs. 

 

 
 

Control Buttons: 

At the top of the graphics display is a row of "Radio Buttons" and a single push button. (Radio buttons are like the 

old frequency select buttons on radios, when you press one, any others are automatically de-selected). The currently 

selected radio button shows the current function of the mouse while you are in the graphics display, with a help bar 

displayed at the bottom of screen to show what each button does.  The Radio button functions operate as follows 

with a separate description for the function of each mouse button, listed Left, Middle and Right 

Zoom : 
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L- Zoom: When this is the selected radio button, you can zoom in on an area of a graph if you wish to look 

atone section of the move more closely.  Decide which area you want to look at, position the mouse in the top left 

hand corner of this area, depress the mouse select button and drag the cursor down to the bottom right hand corner 

of the area you wish to view, and then release it.  As you do this, a moving rectangle will appear to show what area 

you are going to zoom into.  Once the button is released, the section of the move you have selected will be zoomed 

into.  In order to return to the full display, simply double click the left hand select button of the mouse in the graph 

you want to reset. 

M- Rmv Graph:  This will cause the graph you are on to be removed from the display.  This is useful 

forlooking more closely at other graphs.  It may be re-added with the “Display Axes” button. 

R- Flip Screen: This will cause the graph you are on to be displayed on its own, thus facilitating inspection of one 

axis.  Pressing the button again will return you to be previous set of graphs. 

In the Zoom Mode, you can also use the “Alt” key and the mouse to Zoom and Dolly on the screen.  “Alt” and 

middle button causes the system to Dolly and “Alt” and middle and left hand button does a zoom.  This is very 

similar to the Maya™ system, and is most useable with the standalone (no hardware) version of the software when 

this action is done real-time as you drag the mouse. 

Edit Graph: 

L- Move Waypoint: Allows you to edit waypoint positions. 

M- Delete Waypoint: When the middle button is depressed, the closest waypoint to the mouse cursor will 

bedeleted, unless that waypoint is the first or last.  On the numeric display, the entered value at that waypoint will 

be blanked out. 

R- Add Waypoint. Causes a position to be added at the mouse cursor's current position and time.  In the numeric 

display this will be represented as a blank line with a position for only the axis whose graph you were in. 

Tip for editing graphs: As with entering a move, the best way to achieve the shape you want 

is to modify the existing waypoints, not to add lots of points. 

Posn/Vel:  Each graph can also show velocity against time. The velocity profile for the move will only be correctly 

displayed once the move has been calculated with a Forward Run or a Back Run.  If the velocity graph is not wholly 

displayed on the graph, then simply cause the move to be fully calculated, and the graph will be correctly scaled. 

(You can cause the move to be calculated by pressing forward run, and then "STOP", you do not need to actually 

run it).  You cannot edit the velocity graph directly. 

L- Posn: Causes the position only to be displayed 

M- Posn & Vel: causes both the position and the velocity to be shown on the graph.R- 

Vel: causes just the velocity to be displayed. 

Crve: The subject of Curve generation and curve reversal is covered fully in the Chapter on Move Entry in the full 

Flair Manual.  This should be studied in order to get an understanding of what this function does. 

L- Allow Rev: When pressed near a waypoint, allows curve reversal to occur at that waypoint. M- Stop Rev: 

causes curve reversal phenomena to be stopped at the closest waypoint to the mouse when clicked. 

Smooth: When you have a mimic learnt move being displayed on the system, you have the option of smoothing it. 

L- Select Zone: A single press allows the user to drag a box showing the range of time over which the 

movewill be smoothed. 

M- Smooth: Clicking this button causes the selected zone to be smoothed, each subsequent click smoothes 

themove more and more. Each smoothed graph is drawn over the top of the last graph, so you can see the effect as 

you smooth it. 

R- Done: When clicked, the graph is redrawn showing only the smoothed path. 
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Edit Range:  This alters the range over which a graph is altered when the data is recorded as a mimic move or 

discrete samples rather than as curves. See the section on Mimic. 

MOVE ENTRY 

Programming a Move: • Basic law: 

One of the first laws in programming a waypoint type move is to use as few waypoints as needed to achieve the path 

required.  If you "store a point, move a little bit, store another point" and so on, you will almost invariably end up 

with a poor move.  The best way to enter a move is to decide on the start position and plot that, then plot any VITAL 

mid points and then the end point in as few points as possible. Then run the move and see what happens. 

Positioning Waypoints: 
The best way to determine where to place a waypoint is to put it at an extreme of the movement.  If you have to start 

far from an object, get closer and then move away, the obvious points to plot are the start and end, and a mid point 

which is at the closest you want to be to the object 

Modifying a Move: 

Once the move is entered in its basic form, you may find that it is not exactly the move you wanted.  The first thing 

to check is that it is correct at the waypoints.  If it is not, change these until it is and only start adding waypoints 

when you cannot effect the change you want with the existing waypoints.  Adding a waypoint is best done by 

finding the frame at which the departure from the intended move is greatest. (you can do this by watching the move 

and seeing where the slider bar is when the move leaves the desired path by the most.) Then run the move to the 

place where it is worst, insert a waypoint at that point of the move, then correct the positions so that the correct path 

is more closely followed, and store the necessary positions.  Then run this and continue correcting as needed to get 

the path right.  Again, it is usually better to use fewer rather than more points. 

Curve Form: 

The actual behaviour of the computer curve fitting may not be exactly what you wanted; for example if you had a 

move followed by 2 positions exactly the same (a hold), the computer generated curve would naturally go from the 

first point to the second point, then overshoot it and end up at the third point.  This would not be the desired effect, 

but it is the smoothest way to execute the move as planned.  This particular occurrence can be prevented by 

informing the computer that 2 identical positions next to each other are a hold, and the motor is not supposed to 

move between them.  (This is done through the Job Type Display, see the relevant section of this manual for more 

information). 
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Graph showing move with “holds are still” 

 
Graph showing same move with “holds can move”. 

Notice the “curve reversal” overshoot described below. 

Curve Behaviour: 

The above example is rather trivial, but there are more subtle effects that have to be watched for.  One particular 

effect has been termed "curve reversal".  In our use, this term means that while moving between 2 points, an axis 

moves through a position that is not between the 2 points.  If for example you had 3 points on the tilt, each with 50 

frames between the next.  The first point is 10 degrees, the next is 11 degrees, and the last is 25 degrees; since the 

second part of the move is much faster than the first, the natural curve would cause the motor to back up from the 

start to less than 10 degrees in order to get up to the required speed to carry out the second part of the move.  Whilst 

this is the most natural and smoothest curve, it may not be what the user actually intended, and if you have a camera 

moving along close to a floor, and then going up fast, the natural curve would cause it to hit the floor!  This 

phenomenon can be prevented by selecting "Prevent Curve Reversal" in the Graphics display. 
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Here is an example of a curve which reverses, and one which has been handled.  The movement and timings are the 

same on the 2 axes, but the lift clearly exceeds its end position during the move, but has a nice smooth curve.  The 

Track has had curve reversal handled and does not exceed its end position, but it is 2 connected moves, and is not as 

smooth as the lift’s motion. 

Fairings: 

Fairings describe how long between 2 positions an axis will spend accelerating, moving at a constant speed and 

decelerating. They cannot be changed in the graphics display but instead are changed in the Setups>Fairings from 

the Top Menu. Their full use is explained in the Flair manual but below are some examples showing how they affect 

movements: 



Quick Start guide to using Flair        

19 

 

Diagram shows position and velocity graphs for the same two waypoints but with different 

fairings. Track – 10% fairings. Lift - 30% fairings. Rotate – 50% fairings. Extend – 10% up 

fairing, 70% down fairing. 

JOB TYPE 

The Job Type Display is composed of various switches which affect the way in which the system operates, and how 

jobs are run.  Each switch has a name on the left, and on the right is a toggle button that allows you to change the 

state of that switch. Clicking with the left hand mouse button will advance the setting to the next state.  Clicking 

with the mouse stop button (middle button) will set the state back to the default state. 

Save, Accept & Cancel: 

Like many of the dialogue boxes, changes you make are not automatically accepted.  You can check that the 

changes are to your liking before you accept, or you can throw away the changes just by pressing "Cancel".  If you 

want to set default values for the toggles so that every time you turn the system on they start in a certain state, 

simply select the desired states and use the "Save" button to store these to disk.  This will ALSO save the state of the 

Target Tracking toggle which is on the Control Side Menu Bar. 
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Fairings:  User / Computer 

When a 2 point move is being run, the user can allow the computer to generate its own fairing for the move, or the 

user can define his own.  See Chapter 9 "Move Entry" for further data about fairings.  The computergenerated 

fairing causes the motor to speed up for half the move, and slow down for the second half. Computer-generated 

fairings are the equivalent of setting the user fairings to 50%. 

Holds  - are still / can move 

When 2 identical positions are followed or preceded by a different one, it is possible to draw a curved path through 

all three points, and this may be what is desired.  More usually, 2 identical positions indicate a hold, and this switch 

will cause a hold to occur between adjacent identical positions as opposed to making a curve between them. 

Focus - is independent / follows object / follows target 

The focus axis can be driven as a normal axis running between entered points, and when this switch is in the "is 

independent" state, that is what happens.  There are 2 other states in which the focus is driven to hold focus on a 
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target which moves.  In this way, target distances can be measured, and the focus will automatically maintain a 

sharp image of the target (or a soft one if you want!)  These 2 modes are "follows object" and "follows target".  

When in "follow object", the distances entered in the focus column are taken as distances to an object, a curve is 

fitted through these, and then as the move is run, the focus is moved to maintain focus on the object as it moves.  

"follow target" is only valid when you are in Target Tracking, and the focus is driven to maintain focus on the 

Target as worked out from the target tracking maths.  "Follows Object" can be used in target tracking, and would be 

particularly applicable if you wanted to target track one particular object, but focus on something else.  When you 

are in "Follows Target", the focus column holds a copy of the Target column, and this will be displayed in brown.  

When you are in "Follows Object", the distances in the focus column are focus distances and are displayed in 

yellow. 

Zoom - is independent / is linearised / in focal length / in view angle 

Tracking in on an object and zooming in both produce a change in the field size at the object you are tracking in on.  

However, while a constant speed track in will produce a constant change of field size, this is not true of most zoom 

lenses.  If you want to create a smooth zoom that looks like a track (ignoring perspective changes), you have to 

linearise the motion of the zoom.  The actual zoom linearisation is done through the lens Set-up which is described 

in Chapter 5 of this manual, however once this Set-up is done, you can use this data in several ways.  If you are in 

"Zoom is Linearised", then the computer will drive the zoom axis to try to achieve a consistent change in field size.  

You can also do this and display the data as the focal length of the lens or optionally as the view angle.  Please note 

that the view angle may not be what you would normally consider to be the view angle as that depends on many 

factors such as the format and whether you consider view angle as horizontal, vertical or diagonal.  The number 

displayed here is merely meant to be indicative of size.  If you require more detail please contact MRMC.  In the 

Focal Length and View Angle modes, you can directly enter focal lengths or view angles as numbers, and the 

reported current position of the zoom axis will reflect the current focal length in millimetres or the current view 

angle in degrees.  When you are in "Focal Length" then the positions column for the zoom axis is shown in blue, if 

you are in "View Angle" then it is shown in green. 

Iris - is independent / in stops 

When the system has an iris axis that is fully configured to drive the iris ring, the iris axis can be programmed in stops 

rather than in axis positions.  This means that you can program a stop change by typing in the stop numbers (e.g. 5.6 

to 11).  This can be useful for changing light conditions and also is used when you are using the system's Variable 

Camera Speed option.  When the iris is in independent mode, then it acts just like a normal axis.  When in the "stops" 

mode the current position of the iris axis will display the current stop on the lens and will be in red. • Camera 

Speed: is fixed / varies / ... / ... 
Turns on and off the variable camera speed functions and sets the exposure compensation option.  You can also 

select to have the move being at fixed speed, but the camera speed to vary.  You of course could not shoot 

repeatable passes at different speeds, but this may be a desirable option. See chapter on Variable Camera Speed 

for a full description of this feature. 

Calibrating a Lens 

With a simple system calibrating a lens is often not required as all one really needs to do is put in the soft limits of 

the lens so the motors don’t drive it too far. In some cases though it is important such as when the numbers on 

screen have to match the lens markings or for more advanced options such as Target Tracking  or CGI import or 

export. This manual will not explain the full lens calibration procedure which is covered in the Flair manual but it 

will describe how to calibrate the lens so the numbers on screen match the focus numbers given by the lens. To do 

this one has to: 

1) Disable the focus motor so you can move it by hand. Move the focus to infinity and direct zero it by selecting 

Zero->Direct Zero->Focus from the Top Menu. 

2) Select a lens using Setups->Lens Setups from the Top Menu. Click on the button saying “Calibrate Focus”. 

3) When the new box appears move the lens to a mid position, normally around 4-7’ (1-2m) is good. In the second 

row right click with the mouse over the left hand box to store the motor position and type in the marking on the 
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lens in centimeters in the right hand box. The left hand number is normally small and positive. If it is negative 

you will need to change the motor direction in the focus axis setup and restore the left hand number. 

4) Move the lens to close focus and store the motor position as above in the bottom left box and type the focus 

value in the bottom right hand box. Finish by pressing the Calculate and then the Apply button. 

5) Assuming you have set up the soft limits of the focus axis as described in the “End of Travel Limits”section 

above (if you haven’t, do so now), you should now right click on the button that says “Focus Axis Setup” in the 

Lens Setup Box. 

6) If you now select Job Type for the Top menu and change Focus to “follows Object”, you focus positions on 

screen will be displayed in centimeters. 
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